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AWS 3M / 4M EXAM REVIEW!!
Photography, Printing, Web-Based Images, History, & Photo Essays:!!
Resolution is how clear your image is.  It is generally measured in pixels.  The word 
pixel stands for picture element.  It is a small square of colour.  When the squares are 
placed close together they make up an image.  The more pixels there are in an image 
the clearer they will be (higher resolution).  The more pixels there are also increases the 
size of the file and the size the image can be enlarged. The less pixels there are, the 
smaller the file size is, but if enlarged, the image will look pixelated or blurry.!!
When you are creating images for print, it is important to have a high resolution file. The 
resolution for print should be 300 ppi which is 300 pixels per square inch. When you are 
creating images for web, it is important to for the file to be small.  The resolution for web 
based images is 72 ppi or 72 pixels per inch.  This is why when images are taken from 
web sites, they cannot be enlarged or printed without becoming pixelated.!!
Colour management is different between screens and print.  If you are creating images 
for print, the colour management system to use is called CYMK.  CYMK stands for 
cyan, yellow, magenta, and black.  These are the colour of inks used by all printers that 
mix to create all of the colour visible in a print.  Web based or screen based images use 
the colour RGB.  RGB stands for Red, Green and Blue.  These are the “primary colours 
of screen based images.  They mix together to create all the colours we see in the 
movies, television or web.!!
Photo Essays are stories created from images alone.  They are often used to tell very 
powerfully emotional stories or report events.  It is true that a picture is worth a 
thousand words because only an image can capture the emotional impact of an event 
or an experience.  Grade 12’s created photo essays.  You will need to be able to 
discuss your work on your photo essay as well as any work presented in a photo essay 
format.  You may also be given a group of photos that you turn into a photo essay.  This 
would include choosing which photos to include and which NOT to include as well as 
which order you feel best conveys the message and why you chose that particular flow.!!
The history of photography was covered in the Grade 11 class.  We studied the 
chronology of photography: camera obscura, daguerrotype, collodian wet plate process 
and the talbot type as well as the social significance of photography with Eadward 
Muybridge, Dorothea Lange, Matthew Brady and Lewis Hine.  Please review these 
notes (they are also available on our website if you have misplaced your notes)!!
Photographic composition was also covered in the grade 11 curriculum.  In this unit, we 
covered the definition of a snapshot vs a photograph, the nine zone grid, weighting, 
lines, space, shape and other elements.  The entire document can be found and 
downloaded on our website under the side bar navigation: “composition in 
Photography”.!!
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PHOTOSHOP REVIEW!!
By this point in the semester, all students should be aware of the toolbar in photoshop 
and which tool performs which task.  Make sure that you are able to label and locate 
tools and describe or define their purpose and role.!!!
Important tools to remember are the dodge tool, the burn tool, the selection tool, the 
magic wand tool, crop, pick, paint bucket, foreground colour, background colour, eraser, 
lasso, spot healing brush, patch, clone stamp and text tool.  These have been the most 
commonly used tools in our experience.!!!
You should also be aware of Photoshop shortcuts.  We use command delete to fill the 
entire background.  We use command “z” to undo an action.  We use command “d” to 
deselect an area.  We hold down the shift key to maintain aspect ratio so we do not 
skew images when we are resizing them.  We also use the shift key when we are 
creating a line to keep the line a straight horizontal or vertical line.!!!
We used photoshop to crop images, fix and adjust images and create shallow depth of 
field.  We also used it to make posters for print.  You need to be aware of different paper 
or preset sizes for print.  For paper sizes, letter size is 8.5” x 11”  (that is standard paper 
size)  legal size is 8.5 “ x 14”  (that is the long sized paper sometimes used for exams)  
ledger sized paper is 11”x14” and is what we generally use for posters.  Photograph 
sizes are 3x5” (wallet), 4x6” (photo album size) 5x7” and 8x10” (large photograph size)!!!
Layers are one of the most important parts of photoshop.  They work like transparencies 
in that the top layer overlaps the once beneath it.  You need to remember how to layers 
work, why they should be named appropriately, and how to lock, unlock, link and view 
the layers.  There are icons that allow us to do all of those actions.  Make sure you 
know them.!!!
Layer styles appear when we double click on the layer.  This menu allows us to drop 
shadows, create strokes (outlines), patterns, gradients and colour overlays.  It also can 
add bevel and embossing effects, inner glows, outer glows, and a satin effect.!!!
We also created images with selective colour, shallow depth of field and black and 
white.  Review the techniques we used to create those effects.  If you cannot remember, 
the tutorials and notes are available for review on our website.  Go to the Videos & 
Tutorials sidebar navigation, hold your cursor there and a fly-out menu will appear 
categorizing the notes into Photoshop, Illustrator, Flash and Final Cut.!!
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ILLUSTRATOR!!
Illustrator is a program that makes vector image.  A vector image is different than a pixel 
based image because instead of using small squares or pixels to make an image, it 
uses a mathematical formula.  This allows the images to be resized in an extremely 
large or an extremely small format without losing any quality.  Vector images are best for 
creating logos, t-shirts, creating fonts and any work where the finished product will be 
on a large scale.!!!
The surface you work on in illustrator is called an artboard.  You can have it set up 
where you have more than one art board open at a time.  The art board does not show 
up when you save your image, it only is a placeholder to see what your work will look 
like on paper.  When you save your illustrator file, the artboard will disappear.  !!!
The first project we used Illustrator for in grade 11 was tracing cartoons of ourselves.  
We used the pen tool to trace our image.  The pen tool created anchor points which can 
be bent or moved to change the size of it.  !!!
Illustrator works extensively with stroke and fill colour.  It also uses swatches to choose 
colour.  Swatches are organized into separate file folders and you can scroll through 
them to choose a colour palette.  There are also gradient swatch folders which can be 
helpful if you are looking for jewel tones, earthy tones etc.  !!!
One of the most interesting things about illustrator is its symbol library.  Symbols can be 
placed and used in any illustration.  They can also be created or modified.  There is an 
extensive symbol library that works much like the colour swatch library in that it is 
organized into folders and can be scrolled through to choose the symbol that fits best 
for your project.  !!!
Illustrator also has a very good perspective grid tool that allows you to create the look of 
3-dimensions on a 2-D surface.  You can line up your edges to follow perspective and 
create the illusion of depth.!!!
Illustrator files are saved as either an .ai file (adobe illustrator) or as a .eps file 
(encapsulated post script)  !!!!!!
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FLASH ANIMATION!!
Flash animation is a program that allows the user to create 2-dimensional animation.  It 
has a timeline, a stage and a toolbar and a library.  This is the workspace we used most 
commonly when working in Flash.  The file we use when we are working in Flash is 
called Actionscript 3.0!!
When using flash, there are two things we are doing.  First, we are drawing or importing 
images and audio into our library.  Secondly, we are animating the items we have put 
into our library.!!
When we are drawing in Flash, we use the toolbar.  You should know the toolbar very 
well by this time.  There are many similarities between the toolbars in Photoshop, Flash 
and Illustrator.  You should be aware of the free transform tool, the shape tool, pen, text, 
eraser, etc.!!
Once you have drawn an image you should select the whole image, right click and save 
as a symbol in your library.  You cannot create any motion tweens on images that are 
not saved in your library.  !!
If you would like to import other images into your library that you did not draw in flash, 
the easiest way is to File>Import to library.  This is true for .jpegs, .eps, .mp3, .wav etc.  
These items will then be stored in your library and be ready to use.!!
If you want to modify something that is in your library, you must drag it to the stage and 
double click to edit it.  You will know it is isolated when you see the double title at the top 
of your stage.  If you modify a symbol, that change will occur in every instance that you 
have that symbol.  Therefore it is sometimes necessary to have multiple drawings of the 
same image.!!
The second part of Flash, is the animation.  The animation occurs on the timeline.  Each 
small rectangle is called a frame.  A frame is a fraction of a second.  We know how 
many frames are in each second by looking at the bottom of the timeline.  It indicates 
the timing by fps or frames per second.  The default timing is 24 frames per second.  
Which means every 24 frames of animation makes 1 second of video.  !!
The timeline has layers.  They work very much like layers in photoshop.  The top layer 
will appear overtop of the ones beneath.  It is extremely important to label your layers in 
the timeline so you can keep track of your motion tweens and symbols.!!
A blank layer will appear white.  This means that there is nothing on it.  A layer that has 
a item on it will appear gray.  A layer that has an item that has been animated appears 
either blue or violet.  In our classes, we did not use the technique that causes the layers 
to turn violet.  !!
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Keyframes are very important in Flash.  A key frame indicates that something has 
occurred. For instance, a key frame will appear when you drag a symbol from the library 
to the stage.  It indicates that symbol has appeared. Key frames in flash are small black 
circles located inside a frame.  Blank keyframes are clear circles inside a frame.  Blank 
key frame are placeholders.  They keep that frame in space and ensure it does not 
move and that nothing will happen to it.!!
Flash has an semi-automated animation feature called a “motion tween”.  A motion 
tween will automatically move an object between one area on the stage and another 
area.  In order to create a motion tween, you must right click on the layers’ timeline and 
then add motion tween.  You can also achieve this effect by Insert>Motion Tween.!!
When you add a tween, that layer timeline turns blue.  You must indicate to the program 
where to move the symbol by selecting the frame and then moving the symbol.  When 
you do this, a dotted line will appear on the stage between the two points where you 
have told your symbol to move.  You may modify the movement by using the pick tool 
and grabbing the anchor points of the dotted line.  This can create arced movement.!!
To add audio to your animation, you must choose a .wav or .mp3 file.  We do this by: 
File>Import to library.  The audio will show up in your library.  Create a new layer for 
your audio and drag the audio onto the stage.  If you wish to place your audio on a 
specific place on the timeline, you must insert a blank frame one frame before you 
would like your audio to begin.  This will hold your place in the timeline.!!
Editing audio in flash is done in the properties panel.  You must have the audio you wish 
to edit selected on the timeline and then open the properties.  By clicking the little pencil 
symbol, you can modify the length and volume of this file.  !!
Flash files are most commonly saved as .swf files.  They can be saved as .mov files but 
sometimes experience lag when saved in this format.!!
To stop a loop from occurring you must put a stop action on the last frame of your 
animation.  !!
FINAL CUT PRO X!!
This year in the grade 12 program we began working with a new program called final 
cut pro x.  This program allows for extensive editing for film and offers some pretty 
amazing video techniques.  Grade 12 students should be prepared to discuss the 
techniques they used for their film editing, including titling, transitions, special effects 
and overlays.  I will be asking you to write a critique of your own work and offer insight 
into your the editing choices you made.!!!!!
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!
GROUP WORK!!
Each class had to be divided up into groups to complete the assigned projects.  You will 
be asked to discuss your group work and perform an evaluation of your group as a 
whole and individual work ethic.  Group work can be both challenging and rewarding.  
You will discuss your experiences both positive and negative in relation to the process 
and the finished product.


